Legal Notices

Novell, Inc., makes no representations or warranties with respect to the contents or use of this documentation, and specifically disclaims any express or implied warranties of merchantability or fitness for any particular purpose. Further, Novell, Inc., reserves the right to revise this publication and to make changes to its content, at any time, without obligation to notify any person or entity of such revisions or changes.

Further, Novell, Inc., makes no representations or warranties with respect to any software, and specifically disclaims any express or implied warranties of merchantability or fitness for any particular purpose. Further, Novell, Inc., reserves the right to make changes to any and all parts of Novell software, at any time, without any obligation to notify any person or entity of such changes.

Any products or technical information provided under this Agreement may be subject to U.S. export controls and the trade laws of other countries. You agree to comply with all export control regulations and to obtain any required licenses or classification to export, re-export, or import deliverables. You agree not to export or re-export to entities on the current U.S. export exclusion lists or to any embargoed or terrorist countries as specified in the U.S. export laws. You agree to not use deliverables for prohibited nuclear, missile, or chemical biological weaponry end uses. Please refer to www.novell.com/info/exports/ for more information on exporting Novell software. Novell assumes no responsibility for your failure to obtain any necessary export approvals.

All files provided in this release are subject to the Novell Developer License Agreement, which can be found in the license.txt file provided in this download.

Copyright © 2004-2005 Novell, Inc. All rights reserved. No part of this publication may be reproduced, photocopied, stored on a retrieval system, or transmitted without the express written consent of the publisher.

Novell, Inc., has intellectual property rights relating to technology embodied in the product that is described in this document. In particular, and without limitation, these intellectual property rights may include one or more of the U.S. patents listed at http://www.novell.com/company/legal/patents/ and one or more additional patents or pending patent applications in the U.S. and in other countries.

Novell, Inc.
404 Wyman Street, Suite 500
Waltham, MA 02451
U.S.A.
www.novell.com

Online Documentation: To access the online documentation for this and other Novell products, and to get updates, see www.novell.com/documentation.
Novell Trademarks

For a list of Novell trademarks, see Trademarks (http://www.novell.com/company/legal/trademarks/tmlist.html).

Third-Party Materials

All third-party trademarks are the property of their respective owners.
# Contents

## About This Guide

<table>
<thead>
<tr>
<th>Section</th>
<th>Pages</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>9</td>
</tr>
<tr>
<td>2</td>
<td>13</td>
</tr>
</tbody>
</table>

## 1 Certification Process

<table>
<thead>
<tr>
<th>Subsection</th>
<th>Pages</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>9</td>
</tr>
<tr>
<td>1.1 Introduction</td>
<td>9</td>
</tr>
<tr>
<td>1.2 Certification Policies</td>
<td>9</td>
</tr>
<tr>
<td>1.3 Certification Process</td>
<td>9</td>
</tr>
<tr>
<td>1.4 Test Results and Audits</td>
<td>10</td>
</tr>
<tr>
<td>1.5 Support Phone Numbers / URL Addresses</td>
<td>10</td>
</tr>
<tr>
<td>1.6 Company Testing Lab</td>
<td>11</td>
</tr>
<tr>
<td>1.6.1 Minimum Hardware Requirements for Test Systems</td>
<td>11</td>
</tr>
<tr>
<td>1.6.2 Optional Hardware for NetWare Servers</td>
<td>11</td>
</tr>
<tr>
<td>1.7 Lab Site Inspection</td>
<td>11</td>
</tr>
<tr>
<td>1.8 Lab Verification</td>
<td>12</td>
</tr>
</tbody>
</table>

## 2 OES NetWare 6.5 Test Suite

<table>
<thead>
<tr>
<th>Subsection</th>
<th>Pages</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>13</td>
</tr>
<tr>
<td>2.1 OES NetWare 6.5 Hardware Configuration</td>
<td>13</td>
</tr>
<tr>
<td>2.2 Setting Up the TestConsole System</td>
<td>14</td>
</tr>
<tr>
<td>2.2.1 Installing SLES 9 on TestConsole</td>
<td>14</td>
</tr>
<tr>
<td>2.2.2 Completing the SLES 9 Installation on TC</td>
<td>16</td>
</tr>
<tr>
<td>2.3 Installing OES NetWare 6.5</td>
<td>17</td>
</tr>
<tr>
<td>2.3.1 Configuring the SUT for Linux TestConsole</td>
<td>21</td>
</tr>
<tr>
<td>2.4 Configuring the NetWare 6.5 Test Suite</td>
<td>22</td>
</tr>
<tr>
<td>2.5 Install Test</td>
<td>27</td>
</tr>
<tr>
<td>2.6 Component Check</td>
<td>27</td>
</tr>
<tr>
<td>2.6.1 Troubleshooting</td>
<td>30</td>
</tr>
<tr>
<td>2.7 Debug Enable Test</td>
<td>30</td>
</tr>
<tr>
<td>2.8 USB Keyboard / Mouse Test</td>
<td>31</td>
</tr>
<tr>
<td>2.8.1 Hardware Configuration</td>
<td>31</td>
</tr>
<tr>
<td>2.8.2 USB Keyboard/Mouse Test Instructions</td>
<td>31</td>
</tr>
<tr>
<td>2.9 Hot Add Test (Required if hot plug slots exist)</td>
<td>33</td>
</tr>
<tr>
<td>2.9.1 Hardware Configuration</td>
<td>33</td>
</tr>
<tr>
<td>2.9.2 Test Notes</td>
<td>33</td>
</tr>
<tr>
<td>2.9.3 Test Instructions</td>
<td>34</td>
</tr>
<tr>
<td>2.10 MP Test</td>
<td>35</td>
</tr>
<tr>
<td>2.10.1 MP Test (Required if for than one logical processor)</td>
<td>35</td>
</tr>
<tr>
<td>2.10.2 Hardware Configuration</td>
<td>35</td>
</tr>
<tr>
<td>2.10.3 Test Instructions</td>
<td>35</td>
</tr>
<tr>
<td>2.10.4 Troubleshooting the MP Test</td>
<td>36</td>
</tr>
<tr>
<td>2.11 Endurance Tests</td>
<td>36</td>
</tr>
<tr>
<td>2.11.1 Server Stress Test</td>
<td>36</td>
</tr>
<tr>
<td>2.11.2 LAN Stress Test</td>
<td>36</td>
</tr>
<tr>
<td>2.11.3 Hardware Configuration</td>
<td>37</td>
</tr>
<tr>
<td>2.11.4 Test Instructions</td>
<td>37</td>
</tr>
<tr>
<td>2.11.5 Troubleshooting the LAN and Server Stress Tests</td>
<td>39</td>
</tr>
<tr>
<td>2.12 NetWare 6.5 Cluster Services Test (Optional)</td>
<td>39</td>
</tr>
<tr>
<td>2.12.1 Hardware Configuration</td>
<td>40</td>
</tr>
<tr>
<td>2.12.2 NetWare 6.5 Cluster Installation</td>
<td>40</td>
</tr>
<tr>
<td>2.12.3 Test Instructions</td>
<td>43</td>
</tr>
</tbody>
</table>
2.13 Submitting Test Results .................................................. 46
  2.13.1 Error Messages .................................................. 47
  2.13.2 Warning Messages ............................................. 47

3 NetWare Client Tests ..................................................... 49
  3.1 Configuring the Tests .................................................. 49
  3.2 Installing the Novell Client for Windows XP ......................... 50
  3.3 Set Up and Configure a NetWare Server ............................ 51
  3.4 Set Up and Configure TestConsole ................................ 51
  3.5 Set Up the Test Project ............................................ 52
  3.6 Run the NIC Tests ................................................... 53
    3.6.1 Troubleshooting ................................................ 53
  3.7 Completing Product Information and Submitting Test Results .... 53
    3.7.1 Error Messages ................................................ 55
    3.7.2 Warning Messages .......................................... 55

A Uninstalling the Test Kit from Any Linux System ..................... 57

B Using TestConsole ........................................................ 59
  B.1 Introduction .......................................................... 59
  B.2 Project Contents .................................................... 59
    B.2.1 Running Tests ............................................... 59
    B.2.2 Selecting and De-selecting Tests ................................ 59
  B.3 Run Queue .................................................................. 60
  B.4 Project Log .................................................................. 60
  B.5 TestConsole Testing Modes .......................................... 60
    B.5.1 Debug Mode .................................................... 60
    B.5.2 Loop Mode .......................................................... 60
  B.6 Troubleshooting .......................................................... 61
    B.6.1 Missing Desktop icon for TestConsole ......................... 61
  B.7 Importing Product Information from an Existing Project ........ 62
  B.8 Submitting Test Results ............................................. 62
    B.8.1 Error Messages ............................................... 63
    B.8.2 Warning Messages .......................................... 64

C DOS Boot Loader Installation Test ........................................ 65

D Identifying Vendor Device IDs ......................................... 67

E Revision History ............................................................ 69
About This Guide

The System Test Tools contains a procedure manual and all test tools necessary to test the Novell® products used in the Novell YesCertified™ system certification process. The manual explains how to install the software and set up hardware and software configurations.

This document contains the following sections:

- Chapter 1, “Certification Process,” on page 9
- Chapter 2, “OES NetWare 6.5 Test Suite,” on page 13
- Chapter 3, “NetWare Client Tests,” on page 49

Audience

This manual is for users who have prior experience with computers, networking, NetWare, DOS, Linux, and Microsoft Windows. The user should be a Certified NetWare Engineer (CNE) before attempting to set up or execute any of the tests in this kit.

Feedback

We want to hear your comments and suggestions about this manual and the other documentation included with this product. Please use the User Comments feature at the bottom of each page of the online documentation.

Documentation Updates

For the most recent version of the System Test Tools, visit System Test Tools for NetWare and SUSE LINUX (http://developer.novell.com/wiki/index.php/System_Test_Tools_for_NetWare_and_SUSE_LINUX).

Additional Documentation

For more documentation on YES Certification, see:

- Novell YES CERTIFIED Program (http://developer.novell.com/devnet/yes/)
- YES certifying hardware (http://developer.novell.com/devnet/yes/page3.html)

Documentation Conventions

In Novell documentation, a greater-than symbol (>) is used to separate actions within a step and items in a cross-reference path.

A trademark symbol (®, ™, etc.) denotes a Novell trademark. An asterisk (*) denotes a third-party trademark.

When a single pathname can be written with a backslash for some platforms or a forward slash for other platforms, the pathname is presented with a backslash. Users of platforms that require a forward slash, such as Linux or UNIX, should use forward slashes as required by your software.
This section covers the following topics:

- Section 1.1, “Introduction,” on page 9
- Section 1.2, “Certification Policies,” on page 9
- Section 1.3, “Certification Process,” on page 9
- Section 1.4, “Test Results and Audits,” on page 10
- Section 1.5, “Support Phone Numbers / URL Addresses,” on page 10
- Section 1.6, “Company Testing Lab,” on page 11
- Section 1.7, “Lab Site Inspection,” on page 11
- Section 1.8, “Lab Verification,” on page 12

1.1 Introduction

Novell Developer Services designed this kit to aid computer system vendors in the process of testing their own computer systems. This kit provides Developer Services partners with the means to set up and maintain labs capable of performing Novell compatibility testing on their computer systems.

Developer Services designed the tests contained in this kit to verify hardware compatibility between systems and Novell products. This kit contains written instructions and test tools for evaluating compatibility. Developer Services highly encourages hardware vendors to use these tools during all phases of their hardware development, not just the final testing phase.

1.2 Certification Policies

This document contains all of the current policies at the time of this printing. New policies can be viewed at the System Development Web site (http://developer.novell.com/devres/system/System_Certification_Policies.pdf).

1.3 Certification Process

1. Ensure that you have the latest System Test Tools documentation. The latest documentation can be downloaded from the NDK (http://developer.novell.com/wiki/index.php/System_Test_Tools_for_NetWare_and_SUSE_LINUX).
2. Create a TestConsole project file for the System Under Test (SUT).
3. Enter information about your product into the project file.
4. Ensure the drivers and adapters used during testing are certified.
5. Perform the tests on the SUT.
6. Review the SUT project file test results.
7. Report any changes to the product information to your assigned engineer.
   Changing System or CPU information in TestConsole will reset the test results.
8. Generate the test report ZIP file and upload the file to the Novell Bulletin System (NBS).
Developer Services will review the test summary.

Once the submission has been moved to a final customer review state, the submission can be released.

### 1.4 Test Results and Audits

Developer Services will review the test results and configuration for accuracy to insure the system meets Novell Developer Services’ standard for compatibility. Most tests require a minimum time for running the test software. If the system encounters errors after the minimum test time, Novell Developer Services reserves the right to determine pass/fail status of the system on that test.

Novell Developer Services will also perform periodic audits on submitted test results. Novell Developer Services may require the product and the test results of that product be shipped to Novell in order to perform an audit. Developer Services will only issue a certification bulletin after the product passes the audit. In the event of an audit failure, Developer Services will suspend authorization to perform testing. Upon failure, Novell will determine whether to completely revoke testing authorization or only temporarily withhold authorization until compliance is fully met.

### 1.5 Support Phone Numbers / URL Addresses

If there are any questions regarding the Novell Developer Services System Test Kit or Novell PartnerNet for Technology Partners programs, please contact the following Novell Developer Services personnel:

**US Support**

| Test procedure setup/configuration issues: Assigned Premier or Advantage partner level engineer | (801) 861-3101 |
| System Certification Program Manager: Mike Johnson | (801) 861-7373 |
| Novell Developer Services agreements: James Austin | (801) 861-5242 |
| Novell Developer Services Fax | (801) 861-5415 |

**European Support**

| Test procedure setup/configuration issues: Assigned Advantage or Premier engineer | +44 [0]1344-724022 |
| Certification Manager: Phil Rowley | +44 [0]1344-724195 |
| Novell Developer Services Marketing: Phil Rowley | +44 [0]1344-724195 |
| Novell Developer Services agreements: James Austin | (801) 861-5242 |
| Novell Developer Services Fax (Administration) | +44 [0]1344-724249 |
| Novell Developer Services Fax (Engineering): | +44 [0]1344-724180 |

**Web Resources**

- YES CERTIFIED (http://developer.novell.com/devnet/yes/)
1.6 Company Testing Lab

All Premier and Advantage partner level participants must set up a test facility at their company for the purpose of performing system certification testing. The test lab must have a minimum of the following:

- Certified NetWare Engineer (CNE)/ Certified Linux Engineer (CLE).
- Current copy of the Novell Software Evaluation & Development Library (NSEDL).
- Current released version of the Consolidated Support Pack (CSP).
- Current copy of the System Test Kit.
- Windows XP (for the workstation in the NetWare tests)
- SUSE Linux Enterprise Server 9 with the latest service pack.
- Novell Linux Desktop (NLD) 9 with the latest service pack.
- SUSE Linux Enterprise (Server and Desktop 10) with the latest support pack.

1.6.1 Minimum Hardware Requirements for Test Systems

- 2 - 7 PC systems with Pentium III or AMD K7 (or better) processors:
  - 512 MB RAM
  - 20 GB hard drive
  - CD/DVD ROM drive
  - Super VGA adapter
- 1 monitor with 800x600 or better resolution for the TestConsole workstation.
- 5 LAN adapters (with cables, crossover cables, hubs, switches, etc.) (e.g., Ethernet 100MB)
- 5 LAN adapters (with cables, crossover cables, hubs, switches, etc.) from a different topology (e.g., Gigabit Ethernet)

1.6.2 Optional Hardware for NetWare Servers

- 2-3 fiber or SCSI shared subsystem and adapters for cluster services testing.

1.7 Lab Site Inspection

Novell Developer Services will perform an initial lab inspection and may perform subsequent annual lab inspections of each authorized self-testing lab. Schedule an appointment through your assigned engineering contact. The lab must pass inspection before Novell Developer Services will authorize the lab to begin system certification testing. If the testing lab fails a site inspection, you must schedule a second inspection at an additional charge of $2500 USD. This fee does not apply to Premier level participants.
1.8 Lab Verification

You may begin system certification testing after successfully completing the site inspection. However, Novell Developer Services must receive the first system for verification testing. Once Novell Developer Services is satisfied with the test lab’s ability to perform and adhere to the testing procedures, Developer Services will authorize the lab to perform system certification as a Novell Developer Services partner. Novell Developer Services may perform periodic site inspections at each authorized test facility to verify continued compliance with Novell Developer Services requirements for system certification. Novell Developer Services will conduct these inspections within forty-eight (48) hours verbal notice. In the event of a failed inspection, authorization to perform testing will be suspended and an additional site inspection must be scheduled at Novell’s convenience and at the test lab’s expense. Testing authorization will not be renewed until the test lab comes into full compliance.
2.1 OES NetWare 6.5 Hardware Configuration

Figure 2-1  Hardware configuration for the NetWare 6.5 tests.
2.2 Setting Up the TestConsole System

The TestConsole (TC) system must use the SLES 9 OS.

2.2.1 Installing SLES 9 on TestConsole

Requirements

- SLES 9 for i386 with the latest service pack
- 512 MB RAM
- 20 GB hard drive
- LAN connection

**NOTE:** All servers with LAN adapters connected to the SUT must have and use a LAN adapter with the same or higher speed than the LAN adapters in the SUT.

Installation Instructions

1. FDisk or delete all existing partitions from all hard drives.
2. Boot the system to SUSE LINUX Enterprise Server 9 SP3 CD1.
3. Select *Installation* <Enter> before the 20 second timeout expires.
4. When prompted, insert CD1 from the original SLES 9 distribution (no service pack).
5. Click *I Agree* at the License agreement.
6. Click *Accept* to install in English (US).
7. Select the software you want to install on the system.
   - 7a Click *Software* under Installation Settings.
   - 7b Select *Full Installation*.
   - 7c Click *Accept*.
8. Adjust the time zone to match your zone.
   - 8a Click *Time Zone* in the Installation Settings window.
   - 8b Click your *region* in the Region menu box on the left side.
   - 8c Click your *time zone* in the Time Zone menu box on the right side.
     Set the system clock to match the time of the other systems on your rack. Having logs with clocks set to the same time will greatly help you troubleshoot your tests because the names of the logs include a time and date stamp.
   - 8d Click *Accept*.
9. Perform the file copy.
   - 9a Click *Accept* at the Installation Settings window.
   - 9b Click *Yes, install* at the Warning screen.
   - 9c Change SLES CDs as prompted: SLES 9 SP3 CD1, SP3 CD2, Original SLES 9 CD 1 (no service pack), original SLES 9 CD2, original SLES 9 CD3, original SLES 9 CD4.

**NOTE:** SLES 9 will reboot automatically after the installation is complete.
After the system reboots, remove the last CD.

Password for user root.

Type **novell** in both fields for the root user password.

Click **Next**.

Click **Yes** to really use the password at the Password too simple prompt.

Click **Yes** at The Password is Lower Case prompt.

Configure the network interfaces.

Click **Network Interfaces** in the Network Configuration window.

Click **Change** in the Network cards configuration window.

Select the adapter and click **Edit**.

Click the **Static address setup** radio button.

Enter an IP address.
- TestConsole—10.1.1.2
- FS4—10.2.1.2
- SUT (NIC 1)—10.1.1.1
- SUT (NIC 2)—10.2.1.1

Edit the Subnet mask, if necessary.

The following Net Mask examples can be used for each correlating machine:
- TestConsole—255.255.255.0
- FS4—255.255.255.0
- SUT NIC 1—255.255.255.0
- SUT NIC 2—255.255.255.0

Click **Host Name and Name Server** in the Detailed Settings box.

Edit the host name (e.g., TC).

The following Host names examples can be used for the Host Name field on each correlating machine:
- TC—TestConsole
- Client—Client
- FS4—File Server
- SUT—System Under Test

Edit the Domain name (e.g., novell.com).

Click **OK** in the Host Name And Name Server Configuration window.

Click **Routing** in the Network Address Setup window.

The following IP Address’s should be used for the Default Gateway on each correlating machine:
- TestConsole gateway IP address: 10.1.1.1
- FS4 gateway IP address: 10.2.1.1
- SUT gateway address: 10.1.1.1
2.2.2 Completing the SLES 9 Installation on TC

The following steps assume that the test kit is not installed on TC. If it is already installed, please uninstall the test kit (see Appendix A, “Uninstalling the Test Kit from Any Linux System,” on page 57) before proceeding.

1 Log in to SLES 9 as root.

   NOTE: The default password is novell.

2 Close the SUSE welcome screen and the Kandalf's Useful Tips window.

3 Open a shell.

4 Insert the current System Test Kit CD. The CD will automount.

   NOTE: It may open behind the shell screen.

5 Answer Yes to the “open with ...” question. Ensure that the “Do not ask again” box is checked.

6 Close the CD contents media window displayed by Konqueror.

7 If a previous version of the test kit was installed, remove all instances of the installation sources.

   7a Type `yast2 inst_source <Enter>`.

   7b Delete every instance of Software Source Media referring to “SCK”.

   7c Click Finish.

---

• Client (Seg. 1): 10.1.1.3
• Client (Seg. 2): 10.2.1.3

11l Click OK in the Routing Configuration window.
11m Click Next in the Network address setup window.
11n Click Finish in the Network cards configuration overview.
11o Click Next in the Network Configuration window.
11p Click No, Skip This Test in the Test Internet Connection window.
11q Click Next on the Test Internet Connection window.
11r Click Next to use the existing configuration in the Service Configuration window.

12 Configure the authentication.

12a Ensure the Local (/etc/passwd) radio button in the User Authentication Method window is selected.
12b Click Next in the User Authentication method window.
12c Click Next in Add a New Local User.
12d Click Yes at the warning about the Empty/user login.

13 Click Next at the Release Notes window.
14 Click Next at the Hardware Configuration window.

   NOTE: Ensure the monitor type and resolution are correct.

15 Click Finish at the Installation Completed screen.
Type `installation_sources -a cd://` <Enter> at the shell prompt.
This command will update YaST with the list of packages (on the CD) that may be installed on the SLES 9 server.

NOTE: If the media fails to mount on a DVD ROM, type the following command:
`installation_sources -a dvd://`

Type `yast2 sw_single <Enter>` at a shell prompt.
Change the filter to `Selections`.
Place a check mark in the `System Certification Software for the TestConsole` box.
Click `Accept` in the lower right hand side of the screen.

NOTE: The install may take several minutes.

At a shell prompt, type `configure_tc <Enter>`.

NOTE: This may take 10-30 minutes before it reports as finished.

Close all shell prompts.
Remove System Test Kit CD from the CDROM drive and the floppy disk from the floppy drive.

Troubleshooting 1
You can test the connection to a TcLink by starting the TcLink with the debug argument (`tclink debug`). Then you can telnet from any system to that tclink (e.g., `telnet 10.1.1.1 7078`). If there is a live connection, the linux tclink should display some information on the screen as a result of the telnet.

On linux, tclink communicates via the 7078 port. On Java, tclink communicates via port 7076 but doesn’t print anything.

Troubleshooting 2
If you are having trouble using YaST to configure the IP addresses of your NICs, you may use the following commands.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>ip addr show dev eth0</code></td>
<td>Show the configuration of the first NIC (eth0)</td>
</tr>
<tr>
<td><code>ip addr del dev eth0 10.2.1.2</code></td>
<td>Remove an IP address from the first NIC (eth0)</td>
</tr>
<tr>
<td><code>ifconfig eth0 10.2.1.2 netmask 255.255.255.0</code></td>
<td>Change the IP address of the first NIC (eth0)</td>
</tr>
</tbody>
</table>

2.3 Installing OES NetWare 6.5

Complete these instructions on the SUT.

1 Prepare for NetWare 6.5 Installation.
   1a Install at least one Novell Developer Services certified LAN adapter for each bus type (minimum two topologies) in the SUT.
1b Attach a mouse and keyboard to the SUT.
1c Attach a storage device to each storage device controller (integrated and stand alone card).
2 Boot the SUT with the OES NetWare 6.5 OS CD in the CD-ROM drive.
3 Select the English Language install and press <Enter>.
4 Continue the installation process.
   4a Make any needed modifications to the regional settings for the server, then select Continue and press <Enter>.
   4b Press F10 to accept the license agreement.
   4c Press F10 to accept the JReport license agreement.
   4d Press <Enter> to select Manual install.
   4e Select Continue and press <Enter>.
5 If partitions exist on the system, remove all NetWare and DOS partitions.
   5a In the Prepare Boot Partition screen, select Modify <Enter>.
   5b Highlight any existing partition and press <Delete>.
   5c Select Yes to continue on any delete warning prompts.
   5d Repeat above steps until all partitions are removed.
6 Create a boot partition.
   6a Select Modify and press <Enter>.
   6b In the Partitions on Hard Disk 0 box, select Free Space and press <Enter>.
   6c Press <Enter> to accept the default DOS partition size (Size in MB: 500).
   6d Select Continue and press <Enter>.
7 Select the settings for the server.
   7a Select Modify and press <Enter> for server settings.
   7b Set Boot OS to NetWare.
   7c Select Continue and press <Enter> at the Server Settings screen. A file copy will start.
8 Ensure that module ACPIDRV is listed as a platform support module if the system uses ACPIDRV, then select Continue and press <Enter>.
9 Modify device types to be installed.
   9a Edit the HotPlug Support Module entry list in the Device Types/Driver Name box if necessary.
   9b Edit the Storage Adapters list if necessary (for both adapters and devices).
   9c Select Continue and press <Enter>.
10 Modify storage device drivers to be installed.
    10a Edit the Storage devices list if necessary.
    10b Select Continue and press <Enter>.
11 Modify device drivers to be installed.
    11a Edit the Network Boards list if necessary.
    11b Edit the NetWare Loadable Modules list if necessary.
11c Select Continue and press <Enter>.

12 If prompted, select Remove all NetWare volumes and partitions <Enter>.

13 Select Create <Enter> to create volume SYS with the default size.

14 Create pools if free space exists.

**IMPORTANT:** If using shared storage for cluster testing, do not create pools or volumes on these devices. You will do this during cluster installation.

14a Select Pools in the Main Menu box and press <Enter>.

14b Press <Insert> to create a pool.

14c Enter a Pool name and press <Enter> (POOL1, POOL2, etc.).

14d Select an available free space at the Available Partitions screen and press <Enter>.

14e Press <Enter> to accept the default partition size.

14f Repeat steps b-e above for each free space available.

14g Press <Esc> to return to the Main Menu.

15 Create Volumes on the available Pools.

15a Select Volumes and press <Enter>.

15b Press <Insert> to create a volume.

15c Enter a new volume name and press <Enter> (e.g., VOL1, VOL2, etc.).

15d Select an available pool other than SYS and press <Enter> (e.g., POOL1, POOL2, etc.).

15e Select Create and press <Enter>.

15f If multiple unallocated pools exist, repeat steps b through e to create volumes on all available pools.

15g Press <Esc> to return to the Main Menu.

16 Select Continue Installation and press <Enter> at the Main Menu. A file copy starts here.

17 Click Next to install a Customized NetWare server.

18 Click Next.

19 Click Copy files at the summary screen.

20 Replace the OES NetWare 6.5 OS CD with the OES NetWare 6.5 Prod Overlay CD then click OK. A file copy starts here.

**NOTE:** It may start automatically.

21 Enter a unique server name (e.g., SUT) and click Next in the Enter the Server Name window.

22 Select the first network adapter.

23 Select the protocols for this adapter.

23a Enter the IP address.

   SUT LAN adapter 1 — 10.1.1.1
   SUT LAN adapter 2 — 10.2.1.1

23b Enter the subnet mask (e.g., 255.255.255.0) in the Subnet Mask field.

23c Leave the Router (Gateway) field blank.
23d Check the IP box under Protocols.
24 Repeat for all LAN adapters.
24a Select the next adapter and repeat the previous step until you have configured all adapters.
24b Click Next when you have configured all adapters.
25 If prompted, click Next at the Host Names window.
26 Do not install Domain Name Services
26a Click Next to continue without configuring the Domain Name Service.
26b Click OK to continue at the Warning message screens.
27 Select the appropriate time zone, and click Next.
28 Install eDirectory on a stand alone server such as the SUT or the first node of a cluster.

**NOTE:** If this is a subsequent node of the cluster, skip to step 29.

28a Select the *Create a new eDirectory tree* radio button, and click Next.
28b Enter a unique name at the Tree Name: field (e.g., SUT-Tree).
28c Enter a unique name at the *Context for Server Object:* field (e.g., Novell).
28d Enter a password (e.g., novell) in the password field.
28e Re-enter the password for verification, and click Next.
29 Install the license on a stand alone server such as the SUT or the first node of a cluster.

29a Insert the Developer Services License Diskette v4.0 into the floppy drive.
29b Record the eDirectory Summary information (for your own information).
29c Click Next at the eDirectory Summary window.
29d Click Browse by the License Location field.
29e Double-click NW6.5 in the left pane.
29f Click the .NLF file in the right pane of the Select a License window.
29g Click OK.
29h Click Next to install the license.
29i If prompted, click Next to accept the context for the license.
29j Click Next at the LDAP Configuration window accepting the defaults.
29k Click Next at the *Novell Modular Authentication Service* (NMAS) window.

**IMPORTANT:** If you are not testing a cluster, skip the following step.

30 Install eDirectory on a subsequent node of the cluster, not on the first node.
30a Select the *Install server into an existing eDirectory or NDS tree* radio button.
30b Click Next to install the server into an existing tree.
30c Click the tree icon to browse for the tree name (e.g., SUT-Tree).
30d Double-click the tree.
30e Highlight the context (e.g., Novell).
30f Click OK to accept the tree and context.
30g Click Next.
30h Enter the user name and password for the tree you just picked (e.g., browsing for the user name is an easy way to get the correct fully qualified context for the user).

30i Click OK.

30j Click Next at the eDirectory Summary window.

30k Click No to not install additional licenses.

30l Click Next at the LDAP Configuration window accepting the defaults.

30m Click Next at the Novell Modular Authentication Service window.

31 When the progress and disk activity is complete, remove the CD and diskette and click Yes to close Install and reboot.

32 Set up SLP.

32a Type SLPDA /a <Enter> at the server console.

32b If prompted, press <Enter> to accept default configuration.

33 Verify that the ACPIDRV.PSM is in the startup.ncf to enable Hyper-Threading on systems with Pentium 4 or Xeon.

33a Type EDIT C:\NWSERVER\STARTUP.NCF <Enter> at the server console.

33b If it is there, press <Esc>, <Esc>, and then select Yes to exit the NetWare Text Editor.

34 Edit the AUTOEXEC.NCF file and configure IP forwarding.

34a Type EDIT AUTOEXEC.NCF <Enter> at the server console.

34b Add the following to the end of the AUTOEXEC.NCF file of the server.

```plaintext
SLPDA
SET CLIENT FILE CACHING ENABLED=OFF
SET LEVEL 2 OPLOCKS ENABLED=OFF
```

34c Edit the line “LOAD TCPIP” to become “LOAD TCPIP FORWARD = YES”.

34d Press <Esc> and select Yes to save the AUTOEXEC.NCF file.

34e Press <Esc> and select Yes to exit EDIT.

34f Type restart server <Enter> at the server console to restart the server and enable the commands you just added.

### 2.3.1 Configuring the SUT for Linux TestConsole

1 Edit the EXPORTS file in SYS:ETC.

1a Go to the bottom of the file and type the following new line:

```plaintext
/sys -nemode -rw -root
```

1b Save the file.

2 Edit the nfsstart.ncf file in sys\system.

2a Find the line that says:

```plaintext
load xnfs
```

2b Edit this line to read

```plaintext
load xnfs -nodnscheck
```
2c  Save the file.

3  Type nfsstop <Enter> at the NetWare console.

4  Type nfsstart <Enter> at the NetWare console.

5  Create an nfs mount on the Linux TestConsole for the SUT.

5a  Log in as root.

5b  Open a shell.

5c  Type mkdir /mnt/<IP Address of SUT> <Enter>.

5d  Type mount -t nfs <IP address of SUT>:/SYS/ /mnt/<IP Address of SUT> <Enter>.

5e  Type ls /mnt/<IP Address of NetWare server> <Enter> and verify the directory is not empty to check for a successful mount (standard sys: directories should be listed).

5f  Close the shell.

2.4 Configuring the NetWare 6.5 Test Suite

1  Create or open the project file in TestConsole.

1a  Click the TestConsole icon on the TestConsole desktop.

1b  Click New in TestConsole if you are creating a test project or click Open if you are using an existing project.

1c  Select the project.

   • If you are creating a new project, select NetWare 6.5/OES Server-Full.
   • If you are opening an existing project, select the project.

1d  Click Select to open the project.

1e  Enter a name in the project file field and click on Save.

NOTE: If you are creating a new project, select Yes at the warning box and refer to the instructions below for entering the correct information.

At this point, you enter the pre-test product information.

The Product and Report Information screen is the product information gathering tool. You must fill in the information in the following tabs before performing any tests:

   • System
   • Company
   • Bus
   • Device
   • Video

2  Enter the System Information

2a  Enter the System Name and Model.

2b  Choose the Computer Type from the drop down list.

2c  Enter the Mother Board Revision.

2d  Enter the system BIOS.
2e Enter the system Memory (RAM) in Megabytes.

3 Select the CPU.
   3a Click the ‘+’ button next to the CPUs field.
   3b If the CPU in the system does not appear on the list, click Search all CPUs to get a complete listing of the CPU types.
   3c Choose the manufacturer from the drop down menu.
   3d Select the appropriate CPU from the list box.
   3e Enter the number of CPUs in the Quantity field, then click OK.

4 Enter the Product Description

The product description field on a YES CERTIFIED bulletin is a way to include additional information about your product that is important, but that is not listed elsewhere on the bulletin.

Requirements for the Product Description

- Product description must be in English and may not exceed 1,000 characters.
- Do not make claims that are difficult or impossible to substantiate, especially over time.
  Example: Do not use phrases like “this is the best...”, “fastest...”, etc.)
- Do not compare your product with other products on the market.
  Example: Do not compare your product to a competitor’s product.
- Everything mentioned in the Product Description must be present in the system during testing. As a bulletin is released for the specific configuration tested, each bulletin applies only to the exact configuration tested. Tested components are those that the certification tests exercise during testing - those which may be included in the product description are those that are exercised by the certification tests.
  Example 1: No components may be listed in the product description that are not in the tested configuration.
  Example 2: If alternate configurations of components are available and desired on a bulletin (video, drives, keyboards, etc.), then a separate bulletin must be created.
  Example 3: If it is desired to list a “variety of options” (hard drives, optical drives, etc. are available, then each must have a separate bulletin.
  Example 4: If a component is not listed on the bulletin in the tested configuration area, but was part of the tested configuration, it may be included in the product description (e.g., sound adapters, firewire/1394 adapters, etc.).
- The Product Description must be consistent with the configuration of this system as shown on the bulletin.
  Example 1: It is not permissible to indicate optional adapter/driver configurations.
  Example 2: It is not permissible to list alternate processor types, unless test results are submitted for these alternate processors.
  Exception: It is permissible to list multiple processor speeds on a single bulletin, provided the same processor type/stepping is used, and all other components are unchanged.

NOTE: Novell reserves the right to remove any information from the bulletin submission that is deemed questionable with regards to this process at its own discretion.
• Any required installation or configuration instructions should not be in the product description, but should instead be included in the configuration notes section of the bulletin.

To provide additional marketing information about your product, the following options are provided:

• Link to a static URL where additional product information can be obtained. Note that the bulletin becomes a static document, so use a link that is not likely to change (you may want to use your company Web site).
• Enter information in the Novell Partner Product Guide (http://www.novell.com/partnerguide/) to provide a marketing description and then request a link to applicable bulletins.

5 If the project is a reduced test project do the following in the Bulletin Note field:
  5a Enter the bulletin number for the system on which full testing was performed.
  5b State the reasons why this configuration qualifies for reduced testing.
  5c Choose the manufacturer from the drop down menu.
  5d Select the appropriate CPU.
  5e Enter the number of CPUs in the Quantity field, then click OK.

6 Select the Company tab.

7 Enter Company Name
   7a Click the ‘+’ next to the company field.
   7b Select the company name by clicking on it.
   7c Click Select.

8 Change the Testing Company name if it is different than the System Company name.
   8a Click the ‘+’ next to the company field.
   8b Select the company name by clicking on it.
   8c Click Select.

9 Type in the Company URL (optional).

10 Select the Bus tab.

11 Add the bus type and number of slots.
   11a Click Add in the Product & Report Information window.
   11b Select the SUT’s bus type.
   11c Enter the number of slots on the BUS.
   11d Click OK.
12 Repeat for each BUS in the SUT.

13 Click the Device tab.

14 Add a non-USB Floppy Drive, if the system has one or more of this device type.

14a Click Add.

14b Select non-USB Floppy from the Select device type field.

14c Click the floppy media size in the Select the non-USB floppy type field and click OK.
15 Add a USB Floppy Drive, if the system has one or more of this device type.

15a Click *Add*.
15b Select *USB Floppy* from the Select device type field.
15c Type in the company and model name of the USB Floppy and click *OK*.

16 Add a USB keyboard, if the system has a USB keyboard.

16a Click *Add*.
16b Select *USB Keyboard* from the Select device type field.
16c Type in the company and model name of the USB keyboard and click *OK*.

17 Add a USB mouse, if the system has a USB mouse.

17a Click *Add*.
17b Select *USB Mouse* from the Select device type field.
17c Type in the company and model name of the USB mouse and click *OK*.

18 Click the *Video* tab.

19 Add the video adapter.

19a Click *Add* in the Product & Information window.
19b If the adapter is in the short list, select the adapter.
19c If the adapter is not in the short list, click *Search all Video Adapters*.

Select the Video Manufacturer.

Select the Video Adapter.

19d Click *OK*.

20 Click *OK* to close the Product and Report Information data entry.

21 Save the Project.

21a Click *Project* from the menu.

21b Click *Save Test Project*. 
22 Choose the project in the Project Contents pane.
23 Select the type of clients on the test rack.
   23a Double-click the type of client you are using for testing in the Project Contents window.
24 Select the SUT.
   24a Double-click SUT Info under the NetWare 6.5 folder to identify the SUT.
   24b Type the IP address that you will use on the SUT (e.g., 10.1.1.1) in the Selection field.
   24c Click OK in the Select Station window.
25 Enable optional tests that correspond to the system hardware.
   25a Double-click Enable USB Keyboard Testing, to test the SUT with a USB Keyboard. You must perform this test to list a USB keyboard on the bulletin.
   25b Double-click Enable USB Mouse Testing, to test the SUT with a USB Mouse. You must perform this test to list a USB mouse on the bulletin.
   25c Double-click Enable Hot Add Testing, if any of the PCI slots on the SUT support Hot-Plug hot add functionality and there is a System Bus Driver (SBD) for NetWare that supports this system.
   25d Double-click Enable MP Testing if the SUT has two or more logical processors. Systems with a single Intel® Pentium® 4 or Intel® Xeon processor with Hyper-Threading require MP Testing because it has two logical processors.
26 Double-click Enable Cluster Testing to test the SUT with NetWare 6.5 Cluster Services.

2.5 Install Test

Objective: Verify the SUT server can install NetWare using the NetWare boot loader.

Test Time: 30 minutes

Requirements:

- TestConsole workstation (TC)
- NetWare 6.5 Support Pack Overlay

1 Open the appropriate project file in TestConsole
2 (Applies only to SUT) Report the status of the NetWare Boot Loader Installation Test in TestConsole.
   2a Double-click Install Test in the NetWare 6.5 test suite.
   2b If the SUT works properly to this point, click YES to report passing test results.
   2c If the SUT will not install, click No to report failing test results and attempt to install NetWare 6.5 using Appendix C, “DOS Boot Loader Installation Test,” on page 65.

2.6 Component Check

1 Perform the Component Check to gather information about the drivers that are loaded on the SUT.
   1a If you haven't already done so, nfs mount to the sys volume (see Step 5 on page 22).
1b Open the appropriate project file in TestConsole
1c Double-click Component Check in the test suite for the operating system.
1d If prompted, answer the questions on any information gathering windows. This will install the test kit tools on the SUT and detect the drivers.
1e Type `SYS:\NOVELLTESTKITS\SYSTEM\NLM\NWSERVER.NCF <Enter>` on the SUT console to start the test kit agent on the SUT.
1f If prompted, click Yes to indicate the test agent is running on the SUT.
1g Click Yes in the Component Check window.

2 Identify the support drivers that were used during testing. Support drivers include .PSM drivers (e.g., ACPIDRV.PSM) or .SBD drivers (e.g., ACPIDRV.PSM). All multi-processor systems require a PSM. The Component Check detects the PSM and SBD drivers that are loaded on the SUT.

2a Click *Edit Product / Report* in the TestConsole window.
2b Click the *Support Drivers* tab in Product & Report Information window.
2c Click *Add Detected* to update the list with PSM and SBD drivers on the SUT.

3 Determine if the LAN and HBA drivers have been certified and match them to their adapter or chipset.

3a Click the LAN tab or HBA tab.
3b Click *Add* in the Product & Report Information window.
3c Select the first driver from the Detected Drivers field.
3d If the driver name starts with “Proposed” the driver has not been certified. Uncertified LAN and HBA drivers cannot be used for system certification. Do one of the following options and run the Component Check again.

OPTION 1: Update `PRODUCTS.TXT`
1. Click *Cancel*.
2. Save the project and exit out of TestConsole.
3. Follow instructions for updating `PRODUCTS.TXT`
4. Go back to the beginning of the Component Check instructions.

OPTION 2: Replace the uncertified driver.
1. Click *Cancel*.
2. Unload the uncertified driver on the SUT.
3. Load a certified driver on the SUT.
4. Go back to the beginning of the Component Check instructions.

OPTION 3: Remove the non-certified component.
1. Click *Cancel*.
2. Down the server and remove the non-certified components.
3. Install components that have certified drivers.
4. Go back to the beginning of the Component Check instructions.

OPTION 4: Test Using the LAN or Storage Test Tools.
Test this driver and adapter/chipset pair using the LAN or Storage Test Kit. Contact your assigned Developer Services engineer for additional information before proceeding with this option.

**NOTE:** If you use the LAN or Storage Tests, see Section 2.6.1, “Troubleshooting,” on page 30.

3e If the driver is certified (the driver ID field contains a number), do one of the following options:

**OPTION 1:** Match the certified driver to the adapter or chipset. Highlight the adapter or chipset that matches the hardware in the SUT. The adapter list is searchable. It can display the adapters that have been previously selected, search on text you enter, or show “other adapter not in products.txt.”

**OPTION 2:** Update PRODUCTS.TXT

1. Click Cancel.
2. Follow the instructions for updating PRODUCTS.TXT.
3. Go back to the beginning of the Component Check instructions.

**OPTION 3:** Use an adapter or chipset that is not on the list.

1. Highlight other in the adapters list and click OK.

**NOTE:** “Other” will only appear on the list of adapters when the driver has been certified.

2. Enter the chipset / adapter manufacturer and model.

3f Click Add to add the driver and adapter/chipset pair.

3g Repeat for each driver / chipset pair.

3h Click Close.

3i Click Add in the LAN and HBA tabs and repeat the above steps until you have matched all of the drivers to adapters or chipsets in the SUT.

**NOTE:** For multiple instances of the LAN adapter/driver, make only one entry in the LAN information.

4 Check for drivers that have not been matched to hardware.

4a Click Verify in the Product & Report Information window to update the list of warnings.

4b If there are any “WARNING UNLISTED - Driver detected: messages do the following:

- Double-click a warning message.
- Follow the instructions above to match any remaining drivers to hardware.
- Click the Refresh button in the Exception Information window.
- Repeat for each driver warning message.

4c Close the Exception Information window.

5 Identify the storage devices in the system.

5a Click the HBA tab in the Product & Report Information window.

5b Click Add next to the Storage Devices field.

5c If the device is in the short list, highlight the device.

5d If the device is NOT in the short list, do the following:
Click the Search all Storage Devices radio button.
Select the device manufacturer.
Select the storage device.
5e Click OK in the Storage Device Product Search window.
5f Repeat for each storage device in the SUT (e.g., CDROM, hard disk drive, etc.).
5g Click OK in the Product & Report Information window.
6 Save the project.

2.6.1 Troubleshooting

If you performed tests using the Storage Kit on the SUT with NetWare, do the following:

1 Edit the AUTOEXEC.NCF file on the NetWare server. Comment out the following lines:

    ;These lines added by the SAS test kit
    SYS:TESTKITS\STORAGE\SAS.NCF
    ;End of the SAS test kit modifications

2 Restart the server so that it comes up without running SAS.NCF.

The Storage Kit creates a RAM disk on the NetWare server, copies the drivers under test to the RAM disk, and loads the drivers from the RAM disk. Depending on where you are in the Storage Kit, the RAM disk may be removed. In any case, the System Kit Component Check will not correctly detect the drivers.

Unmounting the mount

1 Type `umount -l /mnt/<IP Address of NetWare server><Enter>`.

2.7 Debug Enable Test

Objective: Verify the SUT's keyboard can enable the debugger.

Test Time: 2 minutes

- A TestConsole workstation (TC)
- Respective NetWare operating system on the SUT.

Hardware Configuration

Figure 2-2 Debug Test

1 Enable the debugger, produce a register dump, and return to NetWare environment.

1a Bring up the SUT as a NetWare server.
1b Press and hold down the following keys simultaneously:

  <Alt>
  <Left Shift>
  <Right Shift>
  <Esc>

1c Type `R <Enter>`. The display should show a fresh dump of the CPU registers and flag values.

1d Type `G <Enter>`. The test is successful if the “:” console prompt returns and the server continues to run.

2 Bring up the TestConsole workstation and open the appropriate project file.

3 Log Debug Enable Test to the database manually.

3a In the Project Contents pane, click the plus icon next to the NetWare 6.5 icon to display the details of the test suite.

3b Double-click Debug Enable Test.

3c Click Yes if the server entered the debugger and then continued to run normally, or No if it did not.

2.8 USB Keyboard / Mouse Test

This test is required for systems with a USB keyboard and/or mouse.

Objective: Verify the SUT’s USB keyboard and mouse function in NetWare.

Test Time: 10 minutes

- A TestConsole workstation (TC).
- Appropriate NetWare operating system on the SUT.
- USB Keyboard and mouse.

2.8.1 Hardware Configuration

2.8.2 USB Keyboard/Mouse Test Instructions

1 If system supports legacy emulation, the server must be installed with only the USB keyboard/mouse attached. If legacy emulation is not supported, the OS install can be done with a USB keyboard/mouse attached in addition to the standard keyboard/mouse.

2 Test USB hot-add functionality of keyboard/mouse with NetWare or Appliance.
2a If the system was not installed with USB keyboard/mouse attached, plug the keyboard/mouse into an available USB port.

2b Unplug the USB keyboard/mouse.

2c Replace the keyboard/mouse. (If there is more than one USB port available, replace the keyboard/mouse in a different port.)

2d Verify that keyboard continues to function normally.

2e Switch to GUI console and verify that mouse continues to function (This may not be supported in an appliance OS).

3 Test keyboard functionality.

3a Press <Ctrl><Esc>. Then release both keys.

3b Press <Alt> and look for the current screen title highlighted at the top of the screen.

3c FAIL this test if the current screen title is not Selection Screen.

3d Press <Esc>.

3e Press <Alt> and look for the current screen title highlighted at the top of the screen.

3f FAIL this test if the current screen title is not System Console.

3g Press <Alt><Esc>. Then release both keys.

3h Press <Alt> and look for the current screen title highlighted at the top of the screen.

3i FAIL this test if the current screen title is not Logger Screen.

3j Press <Ctrl><Esc>. Then release both keys.

3k Enter the number corresponding to the X Server - Graphical Console and press <Enter> (This may not be supported in an appliance OS).

3l Press <Caps-Lock> several times, move the mouse, and switch in and out of the Graphical Console (This may not be supported in an appliance OS).

3m FAIL this test if the server quits functioning properly, (e.g., it quits switching screens).

3n Verify that alpha and numeric keys will repeat when held down.

3o Perform the Debug Enable Test using the USB keyboard.

4 Test mouse functionality (This may not be supported in an appliance OS).

4a Press <Alt><Esc> to switch to the GUI Console.

4b Verify that the mouse/cursor will scroll smoothly across the screen.

4c Use the mouse to close the GUI Console.

4d Type STARTX <Enter> at the console prompt to restart the GUI Console. Verify that the mouse continues to function.

5 Verify continued functionality after downing the server to DOS. (applies to legacy emulation only)

5a Press <Ctrl><Esc>, then press <Esc> to switch back to the System Console.

5b Type DOWN <Enter>.

5c Wait 5 minutes.

5d Power on the server.

5e Attempt to use the keyboard to enter the ROM BIOS setup utilities.

5f Fail the test if the typed keys did not control the machine during the boot process.
6 Log USB Keyboard Test in TestConsole.
   6a Open the project in TestConsole
   6b If needed, enable USB Keyboard test by double-clicking on Enable USB Keyboard Testing.
   6c Double-click USB Keyboard Test.
   6d Click Yes or No to indicate if the test passed.
7 Log USB Mouse Test in TestConsole.
   7a If needed, enable USB Mouse test by double-clicking on Enable USB Mouse Testing.
   7b Double-click USB Mouse Test.
   7c Click Yes or No to indicate if the test passed.

2.9 Hot Add Test (Required if hot plug slots exist)

Objective: Verify the Hot Add capability of the SUT’s System Bus Architecture functions in NetWare.

Test Time: 1 hour

- NetWare with SBD Hot Add capability on the file server (SUT)
- A TestConsole workstation (TC)
- The appropriate SBD driver is loaded on the SUT
- A LAN connection to the TestConsole client (preferably a LAN adapter in a non-hot plug slot).
- Additional LAN adapter on hand to temporarily place in each PCI Hot Plug slot
- The tester must know how many and which PCI slots the system Bus Driver controls

2.9.1 Hardware Configuration

Figure 2-4 Hot Add Test

2.9.2 Test Notes

1 When you install an adapter, press enter to ignore the error message that the SYS volume is not available. The test prevents install from modifying the autoexec.ncf file.
2 To retry the test after a failure:
   2a Select ‘Y’ to retry
   2b If retrying “open interlock” first make sure the latch is closed, then open it.
2c If retrying “close interlock” first make sure the latch is open then close it.
2d If retrying “extract card”, first make sure the card is inserted then extract the card.
2e If retrying “insert card”, first make sure the card is extracted then insert the card.

Note that the test is monitoring the slot's CHANGE TO final state, not its final state.

Example: When asked to insert an adapter, it is the act of inserting the adapter that the test looks for. It is not sufficient that the adapter be in the slot. You must remove and reinsert the adapter. Also, do not close the interlock before the prompt appears, otherwise a “close of interlock” will be the slot's change to the final state.

4 We recommend that you fill the slots that do not support hot add with HBAs and the LAN card that connects to the segment with TestConsole. If all slots in the SUT support PCI Hot Add, you must run through the test once, skipping the slots that contain host bus adapters and the LAN adapter that connects to the segment with TestConsole. (SBD Test will keep track of the skipped slots.) Then you must move the adapters to previously tested slots, and run through the test again, testing only the previously skipped slots. SBD Test will prompt you with this information. Repeat this process for each PCI Hot Add slot.

2.9.3 Test Instructions

1 Set the SUT up for test.
   1a Install one LAN adapter into an available PCI Hot Plug bus of the SUT. For this test you must test all PCI Hot Plug slots before the test passes.
   1b Connect another LAN to the TestConsole segment. Use the onboard LAN or a LAN adapter in a non-Hot Plug slot to connect to TestConsole.
   1c Boot the SUT to NetWare 6.x and load ODINEB.NLM
   1d Load the (vendor supplied) SBD.NLM:

2 Perform the test at TestConsole.
   2a If not already done, double-click the Enable HotAdd Testing.
   2b Double-click HotAdd Test.

3 Follow the prompts at the SUT.
   3a When the test prompts you to insert a LAN adapter (and cable), use the cable that goes between the HUB and the SUT in the diagram. Insert the temporary LAN adapter.
   3b At the “New Adapter Hardware has been detected” prompt, press <Enter> to continue.

4 Configure Adapter Protocol
   4a At the NetWare Installation Screen “Configure the Protocols” select Configure Protocols and press <Enter> to continue.
   4b Highlight the installed driver / adapter which was just added and press <Enter>.
   4c Select Configure IP Protocol and press <Enter> to continue.
   4d Highlight the proper frame type (e.g., Ethernet_II) and press <Enter> to continue.
   4e Select Modify Protocol Properties and press <Enter> to continue.
   4f Enter the IP address, Subnet mask, and Gateway. (10.1.1.1, 255.255.255.0, 10.1.1.1)
   4g Select Continue and press <Enter> to continue.
   4h Select Return to driver summary and press <Enter> to continue.
4i Select *Continue* and press <Enter> to continue. Control returns to the test screen.

**NOTE:** You can avoid a long wait or having to reboot the client if you always log into another server before you disconnect the cable from the SUT.

5 The test tools will log the results in the TestConsole database.

**NOTE:** LAN drivers that support persistent (fail over) mode by default cannot be used in testing of SBD systems that support Hot Add.

5a Click *Edit / Report* in the TestConsole window.

5b Click *Support Drivers* tab in Product & Report Information window.

5c Click *Add Detected* to update the list with PSM and SBD drivers on the SUT.

### 2.10 MP Test

Perform this test if the system has multiple processors.

#### 2.10.1 MP Test (Required if for than one logical processor)

**Objective:** Verify each processor of a multi-processor system functions under stress in NetWare.

**Test Time:** 1 hour

#### 2.10.2 Hardware Configuration

*Figure 2-5*  * Concurrent Tests

Subnet: 255.255.255.0

#### 2.10.3 Test Instructions

1 Bring up the SUT with the appropriate NetWare OS.

2 Bring up the TestConsole workstation.

   You should already have an NFS mount of the SYS volume. If you don't, see *(Step 5 on page 22)* for instructions.

3 Open the appropriate project file in TestConsole.

4 Double-click *Enable MP Testing*.

5 Double-click *MP Test*.

   The test will run for 1 hour and the test tools will log the results to the TestConsole database.
2.10.4 Troubleshooting the MP Test

You may ignore the following error message:

Illegal request detected by routine kMutexFree

2.11 Endurance Tests

The Server Stress Test and LAN Stress tests must be run at the same time.

2.11.1 Server Stress Test

Objective: Verify the SUT will function under stress for an extended amount of time.

Test Time: 12 hours

2.11.2 LAN Stress Test

Objective: Verify the SUT will connect to network stations that use different types of transmission media and low level addressing while stressing the SUT.

Test Time: 12 hours

- NetWare on the SUT
- The SUT must have at least 2 LAN adapters installed. The SUT must have at least one LAN or Storage adapter in each bus type. Each bus need not be populated with a LAN adapter as long as each bus type is populated.
- One SLES 9 or Windows XP client per LAN adapter in the SUT.
- TestConsole workstation (TC)
- A minimum of two LAN topologies must be tested (100 Mb Ethernet, Gigabit Ethernet).
- Set IMMEDIATE PURGE OF DELETED FILES = ON (for volumes under 9GB)
2.11.3 Hardware Configuration

Figure 2-6  Endurance Tests

2.11.4 Test Instructions

1. Bring up the SUT with the appropriate NetWare OS.
2. On the TestConsole workstation, nfs mount to the sys volume on the SUT if prompted.
3. On the TestConsole workstation, start TestConsole and open the appropriate project file.
4. Run endurance testing setup.
   4a. Double-click Setup 12hr Endurance Testing.
   4b. Enter the number of NICs/Busses to be tested.
   4c. Click OK.
5. Run Endurance Tests test group.
   5a. Double-click Endurance Tests (12hr) test group.
   5b. Click Continue to run all of the tests in this test group.
   5c. Follow the instructions and answer the questions on the popup screens (if prompted to install kit on SUT select Yes).
6. If you are using Linux clients, create a mount on the Linux clients.

NOTE: Refer to Section 2.2.1, “Installing SLES 9 on TestConsole,” on page 14 for more information.
6a Assign the gateway on each workstation as shown in Hardware Configuration diagram for Endurance Tests.

6b Open a shell.

6c Type `mkdir /mnt/<IP Address of SUT> <Enter>`.

6d Type `mount -t nfs <IP address of SUT>:/sys/ /mnt/<IP address of SUT> <Enter>`.

6e Type `ls /mnt/<IP address of SUT> <Enter>` and verify the directory is not empty to check for a successful mount.

6f Type `bash /mnt/<IP address of SUT>/NovellTestKits/system/bin/suseclient.bash <Enter>`.

7 If you are using Windows XP clients, map drive T: to sys:\.

7a Log in the Windows client to the SUT.

7b Map T: to sys:\.

7c At a command prompt (run), type:

```
T:\NovellTestKits\System\bin\Xpclient.bat.
```

8 On TC, click Yes if the clients are running TCLink.

9 Identify workstation IP addresses

9a If the workstation is on the same segment as TestConsole, click the line that represents a workstation.

9b Click Full List to display an unfiltered list or Refresh to refresh the list.

**NOTE:** The client IP addresses are entered in the segment order. The first IP address entered must be on one segment, then the next one on the next segment, and so on.
9c You may need to manually type in the IP address in the selection field if a workstation does not appear in the list.

9d Click OK.

9e Repeat for each workstation.

10 The File Access Test will start on the workstations. DTS and Server Stress Test will start on the SUT. These tests will run for 12 hours and the test tools will log results in the TestConsole database.

2.11.5 Troubleshooting the LAN and Server Stress Tests

Make sure that each client has the server (IP Address) assigned as the gateway. See the Hardware Configuration Section for details.

If the System Test Kit will not automatically install on the test clients, install it manually on each client.

2.12 NetWare 6.5 Cluster Services Test (Optional)

Objective: Verify the SUT will fail over, fail back and migrate individually managed cluster resources.

Test Time: 30 minutes

- NetWare 6.5 on each of the servers (see Section 2.3, “Installing OES NetWare 6.5,” on page 17)
- TestConsole workstation (see Section 2.2.1, “Installing SLES 9 on TestConsole,” on page 14)
- All servers must be in the same NDS tree
- Cluster Services on each system in the cluster
- All servers must have a connection to the shared subsystem
- IP protocol, same IP subnet on all servers in the cluster
- Windows XP workstation with Client 32.
2.12.1 Hardware Configuration

Figure 2-7  Cluster Services Test

2.12.2 NetWare 6.5 Cluster Installation

1. If using iSCSI, restart all servers and verify connection to the iSCSI target.
2. Bring up all servers that will be in the cluster.
3. Log in the Windows XP client (with 90MB RAM and the current Novell client) to the SUT.
4. Browse to volume SYS of all nodes from Network Neighborhood.
5. Insert the NetWare 6.5 OS CD in the CD drive of the client.
   6a. If Novell Deployment Manager does not Autorun, select Start, Run and type `D:\NWDEPLOY.EXE` and click OK (where D: points to the CD drive).
   6b. In the left panel, click Install/Upgrade Cluster under Post-Install Tasks.
   6c. In the main panel click Install or Upgrade a Cluster.
   6d. If prompted, click Yes to allow ActiveX control.
   6e. Click Next at the Novell Cluster Services for NetWare 6.5 Installation window.
7. Create new cluster.
   7a. Select the Create New Cluster radio button
   7b. Click Next.
   7c. Enter a Unique Cluster Object name (e.g., Cluster_Object).
   7d. Click the browse icon.
   7e. Double-click to open the tree that the cluster servers are in.
If prompted, authenticate as user admin.

Select the server context within the tree (e.g., Novell), and click OK.

Click Next.

Add servers to the cluster.

Click the browse icon.

Select all of the servers that you want to add and click Add. You may use the shift and control keys to select multiple nodes.

Click OK when all servers in the cluster appear on the list. Please wait while NWDeploy accesses each node.

Click Next after all servers have been accessed and added to the NetWare Servers in Cluster list.

Enter a unique IP address for the Master_IP_Address_Resource (e.g., 10.1.1.5) in the Cluster IP Address Selection window and click Next.

Setup the shared media.

Verify that the Yes radio button next to “Does the cluster have shared media?” is selected.

Select the No radio button next to “…mirror Cluster Partition.”

Click Next to accept the default shared media settings.

Select Yes on Start Options and click Next.

Install the licenses, if you are setting up a cluster with more than a two nodes.

Insert the license diskette into drive A: of the client.

Browse to A:\license.

Select a license for each node and click OK.

Click Next. A file copy and configuration will start now.

Close the Deployment Manager.

Click Close.

Exit the Deployment Manager.

Create Shared NSS Volume

Bring up the cluster.

Press <Alt> <Esc> repeatedly on the SUT until the Cluster Membership Monitor (CMON Screen) appears.

Verify that each node in the cluster is up.

Confirm shared device is shareable.

Type NSSMU at the server console of the SUT.

Select Devices.

Highlight appropriate device.

Press <F6> to mark device shareable. (The device may already be marked shared after cluster services install.)

Press <Esc>.
3 Create NSS partition.
   3a Select Partitions.
   3b Press <Insert>.
   3c Select free space on shared device.
   3d Select NSS for partition type.
   3e Select Create.
   3f Press <Esc> twice.

4 Create shared pool
   4a Select Pools.
   4b Press <Insert>.
   4c Enter a name for the shared pool (e.g., SharedPool).
   4d Select NSS partition created above.
   4e Highlight 1st block of IP Address.
   4f Enter IP address of shared pool (e.g., 10.1.1.6 and press <Enter> after entering each octet).
   4g Select Create.
   4h Press <Esc>.

5 Create shared volume
   5a Select Volumes.
   5b Press <Insert>.
   5c Enter volume name (e.g., SharedVol).
      If prompted to encrypt the volume, select No.
   5d Select the pool created above.
   5e Select Create.
   5f Press <Esc>.

6 Exit NSSMU
   6a Press <Esc>.
   6b Select Yes.

Verify shared volume is in cluster

1 Launch ConsoleOne on the SUT.
2 Browse for the cluster container.
   2a Highlight the NDS icon in the main panel.
   2b Select File, Authenticate to authenticate to the tree.
   2c Expand the network object (i.e., NDS).
   2d Expand the cluster tree object (e.g., Cluster_Tree).
   2e Expand the context (e.g., Novell).
3 Select shared object
3a In left panel, browse to correct context and highlight cluster object.
3b In main panel, double-click the shared object (e.g., SharedPool_Server).
3c Select Nodes tab.
3d Verify all cluster nodes are listed in the assigned window and are in the proper order.
3e Click Apply if changes were made in nodes or click Cancel.

4 Verify cluster object is online
4a Highlight the cluster container object
4b Select View > Cluster State View.
4c Verify shared pool and master IP address are in running state.
4d Select View > Console View.
4e Exit ConsoleOne.

---

**NOTE:** If you make changes, you must take the resource off-line then on-line to activate the changes.

---

**Edit LDNCS.NCF file**

Cluster Services for NetWare 6.5 has a new feature that must be disabled before doing cluster testing with the system Test Kit. The feature involves tracking shared resources and not failing back to a node that has previously failed with the same resources. This is designed to prevent a failing app from cascading through every node in a cluster.

To disable this feature:

1 Remove the read-only attribute on the LDNCS.NCF file located in SYS:\system to enable you to edit the file.
2 Edit the LDNCS.NCF file on each node in the cluster.
3 Look for the line “clstrlib.”
4 Add the following option to the end of that line:
   /HMO=off.
5 Restart all nodes in the cluster.
   5a Type Cluster Down <Enter> on one of the cluster nodes to shut down cluster services on all of the nodes.
   5b Type ULDNCS <Enter> to force the node to leave the cluster on each node.
   5c Type LDNCS <Enter> to force the node to join the cluster on each node.

---

**2.12.3 Test Instructions**

1 Configure the client settings on the Windows XP workstation.
   1a Right-click the red Novell “N” on the toolbar.
   1b Click Novell Client Properties.
   1c Click the Advanced Settings tab.
   1d Select Cluster Connection Validation Interval.
1e Change the setting to 60 seconds from the default of 20 seconds.
1f Select File Caching.
1g Change the setting to OFF.
1h Click OK.
1i Click OK.
1j Reboot the client.
2 Start TestConsole and open the appropriate project file.
3 Double-click Enable Cluster Testing, to enable this test (if not already done).
4 Start the test on TestConsole.
   4a Double-click Cluster Tests (10min/node).
   4b Click Continue to run all of the tests in this test group.
   4c Do not enter the IP address of the XP client yet. Do the following step first.
5 Prepare the Windows XP client to run the cluster test.
   5a Log in to the SUT as user admin.
   5b From the workstation, browse to all nodes in the cluster to ensure that you have a
      connection, including the shared volume of the virtual server.
   5c Map T: to sys:\ on SUT.
   5d From a command prompt, type
      T:\NovellTestKits\System\bin\XpClient.Bat and click OK to copy the
      test kit files to the client.
   5e Verify that the client is running TCLink.
   5f In TestConsole, enter the IP address of the Windows XP client running TCLink and click
      OK.
6 Configure the test on the Windows XP client.
   6a Enter the path of the cluster volume at the Path window using the SharedPool_Server IP
      address and name, (e.g., file://10.1.1.6/SharedVol) and click OK.
   6b Enter the fail over order of the nodes, (e.g., node1;node2;node3). Note that the node
      names are separated by a semicolon. It must be the same order as previously noted when
      you created the cluster volume object. You may find the fail over order list by going into
      ConsoleOne > My World > NDS > tree > context > Cluster_Object > Console View >
      SharedPool_server > Properties > Nodes tab.
   6c Click OK.
   6d If the Node Names popup appears, you have listed your nodes incorrectly. Edit the list and
      click OK again for another test.
   6e Enter the pathless cluster volume name (e.g., SHAREDVOL).
   6f Click OK. The test tool will initialize the environment over a period of a few minutes.
7 Follow the prompts on the Windows XP client.
8 The test tools will log the test results in the TestConsole database.
9 Restore the client on the Windows XP client.
   9a Right-click the red Novell “N” on the toolbar.
   9b Click Properties.
9c  Click the Advanced Settings tab.
9d  Select Cluster Connection Validation Level.
9e  Change the setting to 20 seconds.
9f  Select File Caching.
9g  Change the setting to On.
9h  Click OK.
9i  Click OK.
9j  If prompted, insert the Windows CD.
9k  Reboot the workstation if prompted.

Troubleshooting Cluster Services

If the client loses its connection to the cluster during the test:

1  Use Explorer to browse to the shared cluster volume.
2  Click the CSTest popup window and retry loading the NLM.

Find the volume IP address by going to ConsoleOne, My World, NDS, tree, context, Cluster_Pool_Server, properties.

If you see the following abend, then reboot that cluster node and restart the test:

System Fault Screen
System halted...
Abend on P00: NWCS: Server entered RealMode longer than tolerance allowed.
OS version: Novell NetWare 5.60 July 27, 2001
...Debug symbols are enabled!
Running Process:...
Additional Information:
The NetWare OS detected a problem with the system while executing a process owned by CLSTRLIB.NLM. It may be the source of the problem or there may have been a memory corruption.

Tips and Tricks

For detailed information on configuring different products and components with Novell Cluster Services, see the Novell Cluster Services 1.7 Resource Configuration Guide.

If the shared volume and application do not migrate to other nodes in the cluster (other than the primary), isolate the cluster network, reset the router on each server, and reboot the client. The test should run properly after performing these steps.

If the test hangs, restart each server in the cluster prior to running the test again.

Type “CLUSTER RESOURCES” <Enter> on the server console to show cluster information. This command shows the status of the shared volumes including which node has mounted the volume.

If Cluster Services (CLSTRLIB.NLM) does not start automatically on a node after installation, start it manually by typing CLSTRLIB.NLM <Enter> on the server console.
Home directories cannot be created on cluster enabled volumes using iManager. You must use ConsoleOne to create home directories instead.

If you use software RAID 0 or RAID 5 devices on shared disks, you must create a pool and volume on that RAID device from the same server node before that pool can be migrated.

If you need to power down or recycle your shared storage system, you must unload Novell Cluster Services first. Unload NCS by typing “ULDNCS” <Enter> at the server console of each node in the cluster.

2.13 Submitting Test Results

1 Open the project file.

   **IMPORTANT:** If the project file is already open and you have just completed the tests, save the project before creating the report.

   1a Click the TestConsole icon on the desktop
   1b Click Project > Open Test Project > Existing.
   1c Select the appropriate project.
   1d Click Select to open the project.

2 Create the test report file.

   2a Click Edit Product/Report.
   2b Click Report.

   **IMPORTANT:** If the Report Error window appears, do step 3. If not, skip to step 4.

3 Report errors.

   3a Click OK in the Report Error window.
   3b Click Verify.
   3c Click an exception in the scroll window.
   3d Click Edit Explanation.
   3e Enter the explanation.
   3f Click OK in the explain exception window.
   3g Repeat steps c through f until all unresolved exceptions are explained.
   3h Click OK in the Exception Information window.
   3i Click Report.

4 Complete the test results file.

   4a Type the file name of your choice into the File Name field.
   4b Click Save to generate the test results zip file.
   4c Click View Report Summary to view the reported information in a browser.
   4d Close the browser window.
   4e Click OK to exit the Product and Report Information window.
Copy the test report ZIP file from the /opt/novell/NovellTestKits/system/results directory to a floppy diskette.

At a prompt, type cp <result file name> / media / floppy <Enter>.


### 2.13.1 Error Messages

Error messages will occur for a variety of reasons (e.g., incomplete required information or test results). Error messages indicate problems with required tests or product information. All required tests must be completed or have a valid exception approved by Novell in order to receive a bulletin. TestConsole will produce an error message for each required test that does not pass or have test results. These tests must be completed (or have a valid exception) in order to receive a bulletin.

TestConsole will also generate an error message for each required empty field in the Product and Reporting Information screen forms. Each required field must be completely filled in to receive a bulletin.

**WARNING:** Any changes to fields in the System tab (except the Product Description field) will reset all test results for this product. Contact your assigned Novell engineer if changes must be made to these fields.

### 2.13.2 Warning Messages

Warning messages also occur for a variety of reasons (e.g., incomplete optional information or test results).

TestConsole will generate a warning message for each optional test that does not have test results. For example, if the Cluster tests are not run, there will be warning messages for each test indicating that they do not have results. In this case, the warning messages may be ignored. TestConsole will also generate a warning message for each optional empty field in the Product and Reporting Information screen forms such as the Company URL.
3.1 Configuring the Tests

Objective: Test the Windows requester with the Novell Client as an interface to NetWare over the IP Protocol and stress the Windows Client with a file system endurance test. Transfer data back and forth between the server and the local disk.

Test Time: 4 Hours

- A TestConsole workstation (TC)
- One File Server running NetWare 6.5.
- One client (SUT) running Windows 2000 or XP.
- One client (Traffic client) running Windows XP.
- The Novell Client installed on the SUT and Traffic client.

Hardware Configuration

NOTE: Perform the Novell Client NIC test on all LAN adapters to be listed on the bulletin.
3.2 Installing the Novell Client for Windows XP

These installation steps are specific to installing the Novell Client on Windows XP.


2. Extract the client files to a directory on SUT.

3. Install the Novell client.
   3a. Browse to the directory where you extracted the client files.
   3b. Double click on setupnw.
   3c. Select Custom Installation and click Next.
   3d. Click Next to install the Novell Client for Windows.
   3e. Click Next to accept the installation of NMAS.
   3f. Select IP and IPX and click Next.
   3g. Select NDS as the login authenticator and click Next.
   3h. Click Finish to initiate the file copy.
   3i. Click Reboot to restart Windows. Remove the Novell Client CD.

4. Set the file caching parameter.
   4a. Right-click the red Novell N on the taskbar.
   4b. Click Novell Client Properties.
   4c. Click the Advanced Settings tab.
   4d. Select File Caching.
   4e. Change the setting to OFF.
   4f. Click OK to save the change and close the Novell Client for Windows Properties window.
   4g. Click No to on the reboot now message.

5. Add IPXCosting to the registry.
   5a. Click the Start button.
   5b. Select Run.
   5c. Type REGEDIT <Enter>.
   5d. Click the plus icon next to HKEY_LOCAL_MACHINE.
   5e. Click the plus icon next to SYSTEM.
   5f. Click the plus icon next to ControlSet001.
   5g. Click the plus icon next to Services.
   5h. Click the plus icon next to Netware Workstation.
   5i. Click Parameters.
   5j. Right-click the white space in the right window pane and select New > DWORD Value.
   5k. Type IPXCosting <Enter>.
   5l. Right-click IPXCosting and select Modify.
   5m. Type 0 <Enter> in the Value data: field.
5n Close REGEDIT.
6 Restart the system to allow the new setting to take effect.

### 3.3 Set Up and Configure a NetWare Server

1 Set up a NetWare 6.5 server (see Section 2.3, “Installing OES NetWare 6.5,” on page 17).
2 If the NetWare 6.5 server has a previous version of the test kit installed, do this step.
   2a On the server console, type `bash <Enter>`.
   2b Type `rm -R /NovellTestKits <Enter>`.
   2c Type `exit <Enter>`.
      At this point you configure the NetWare server for the Linux TestConsole.
3 Edit the `EXPORTS` file in `SYS:ETC`.
   3a Browse to `SYS:ETC` and open the `EXPORTS` file.
   3b Go to the bottom of the file and type the following new line:
      `/sys -nwmode -rw -root`
   3c Save the file.
4 Edit the `nfsstart.ncf` file in `sys:system`.
   4a Find the line that says:
      `load xnfs`
   4b Edit this line to read
      `load xnfs -nodnscheck`
   4c Save the file.
5 Type `nfsstop <Enter>` at the NetWare console.
6 Type `nfsstart <Enter>` at the NetWare console.
   The NetWare server is now configured for TestConsole.

### 3.4 Set Up and Configure TestConsole

1 Set up SLES 9 on a system to use for TestConsole (see Section 2.2, “Setting Up the TestConsole System,” on page 14).
2 Create an nfs mount on the Linux TestConsole for the SUT.
   2a Log in as root.
   2b Open a shell.
   2c Type `mkdir /mnt/<IP Address of NetWare server> <Enter>`.
   2d Type `mount -t nfs <IP address of NetWare server>:/SYS/ /mnt/<IP Address of NetWare server> <Enter>`.
   2e Type `ls /mnt/<IP Address of NetWare server> <Enter>` and verify the directory is not empty to check for a successful mount (standard sys: directories should be listed).
   2f Close the shell.
3.5 Set Up the Test Project

1 Click the TestConsole icon on the desktop or type TestConsole <Enter> at a shell prompt.

2 Open the project file.
   2a Click Project > Open Test Project > New.
   2b Select the WinXPClient Workstation - Full project for a full test or WinXPClient Workstation - Reduced project for a reduced test.
   
   **NOTE:** Refer to the Hardware Exchange Guide Policy to determine whether a full or reduced test is required.

   2c Click Select to open the project.
   2d Enter a name in the project file field and click on Save.
   2e At the warning screen, click Yes to enter the system information.
   2f Complete all the fields in the Product and Report Information window for the following tabs:
   - Company
   - System
   - Bus
   - Device
   - Videos
   
   For more information, see the test instructions in Section 2.4, “Configuring the NetWare 6.5 Test Suite,” on page 22.
   2g Click OK to close the Product and Report Information window when all tabs have been filled in.

3 Select the Server IP Address.
   3a Double-click Server IP Address to identify the NetWare Server.
   3b Type the IP address of the Server (e.g., 10.1.1.1) in the Selection field.
   3c Click OK.

4 Select the SUT IP Address.
   4a Double-click SUT IP Address to identify the SUT.
   4b Select the IP address of the SUT from the list or type the address (e.g., 10.1.1.3) in the Selection field.
   4c Click OK.

5 Select the Traffic IP Address.
   5a Double-click Traffic IP Address to identify the SUT.
   5b Select the IP address of the traffic client from the list or type the IP address of the traffic client (e.g., 10.1.1.4) in the Selection field.
   5c Click OK.
3.6 Run the NIC Tests

1 For the WinXPClient Workstation - Full project, select the Number of NICs to test which will be supported in this configuration.
   1a Double-click Setup number of NICs to Test.
   1b Enter the number of NICs in the SUT to be tested (1 to 4).
   1c Click OK.

2 Start the test on TestConsole.
   2a Double-click NIC 1 Test (4 Hrs.) for the Client Full test or NIC 1 Test (0.5 Hr.) for the Client Reduced test.
   2b If prompted, click Continue to run all of the tests in this test group.
   2c Click Yes to confirm the correct IP address for your server.
   2d If prompted to install the test kit on your server, click Yes (It may take several minutes to continue as the kit is being installed on your server).
   2e If prompted, click OK on the TestConsole Login Script message screen.
   2f The Check Client Setup screen will appear. Follow the instructions listed on the screen.
   2g If prompted to start the test kit software on the NetWare server, type SYS:\NOVELLTESTKITS\SYSTEM\NLM\NWSERVER.NCF at the NetWare server console.
   2h Click OK.
   2i For the WinXPClient Workstation - Full project, repeat 2a -2b for each additional NIC in the SUT.

NOTE: When testing additional NICs, disable all NICs but the NIC to be tested and make sure that the NIC to be tested is connected to the server.

3.6.1 Troubleshooting

1 Perform the Novell Client NIC test with only one NIC installed or enabled in the SUT at a time.
2 TestConsole cannot support multiple projects running simultaneously.
3 Make sure all clients are logged into the NetWare server.
4 Make sure that TCLink-Java is running on the SUT and Traffic client.

3.7 Completing Product Information and Submitting Test Results

1 Open the project file.

IMPORTANT: If the project file is already open and you have just completed the tests, save the project before creating the report.

   1a Click the TestConsole icon on the desktop
   1b Click Project > Open Test Project > Existing.
   1c Select the appropriate project.
1d Click *Select* to open the project.

2 Identify the LAN adapters in SUT.

2a Click *Edit Product/Report*.

2b Click the *LAN* tab.

2c Click *Add*.

2d Highlight the LAN adapter or chipset that matches the hardware in SUT.

2e Click *Add*.

2f Repeat 2d-2e for each LAN adapter or chipset.

2g Click *Close*.

3 Identify the HBAs in the SUT.

3a Click the *HBA* tab.

3b Click *Add* to the right of the HBA information field.

3c Highlight the storage adapter or chipset that matches the hardware in SUT.

3d Click *Add*.

3e Repeat 3c-3d for each HBA or chipset in SUT.

3f Click *Close*.

4 Identify the storage devices in the system.

4a Click *Add* to the right of the *Storage Devices* field.

4b If the device is in the short list, highlight the device.

4c If the device is not in the short list, do the following:

   Click the *Search all Storage Devices* radio button.
   Select the device manufacturer
   Select the storage device.

4d Click *OK* in the *Storage Device Product Search* window.

4e Repeat steps 4a-4d for each storage device in the SUT (CD ROM, hard disk, etc.).

5 Click *Report* to create the test report file.

**IMPORTANT:** If the Report Error window appears, continue to step 6. If not, proceed to step 7.

6 Report errors.

6a Click *OK* in the Report Error window.

6b Click *Verify*.

6c Click an exception in the scroll window.

6d Click *Edit Explanation*.

6e Enter the explanation.

6f Click *OK* in the explain exception window.

6g Repeat steps c through f until all unresolved exceptions are explained.

6h Click *OK* in the Exception Information window.

6i Click *Report*.
Complete the test results file.
7a Type the file name of your choice into the File Name field.
7b Click Save to generate the test results zip file.
7c Click View Report Summary to view the reported information in a browser.
7d Close the browser window.
7e Click OK to exit the Product and Report Information window.
8 Copy the test report ZIP file from the /opt/novell/NovellTestKits/system/results directory to a floppy diskette.
8a At a prompt, type cp <result filename> /media/floppy<Enter>.

3.7.1 Error Messages

Error messages will occur for a variety of reasons (e.g., incomplete required information or test results). Error messages indicate problems with required tests or product information. All required tests must be completed or have a valid exception approved by Novell in order to receive a bulletin. TestConsole will produce an error message for each required test that does not pass or have test results. These tests must be completed (or have a valid exception) in order to receive a bulletin.

TestConsole will also generate an error message for each required empty field in the Product and Reporting Information screen forms. Each required field must be completely filled in to receive a bulletin.

WARNING: Any changes to fields in the System tab (except the Product Description field) will reset all test results for this product. Contact your assigned Novell engineer if changes must be made to these fields.

3.7.2 Warning Messages

Warning messages also occur for a variety of reasons (e.g., incomplete optional information or test results).

TestConsole will generate a warning message for each optional test that does not have test results. For example, if the Cluster tests are not run, there will be warning messages for each test indicating that they do not have results. In this case, the warning messages may be ignored. TestConsole will also generate a warning message for each optional empty field in the Product and Reporting Information screen forms such as the Company URL.
Uninstalling the Test Kit from Any Linux System

1. Log in to the system as root.
2. Open a shell.
3. At the shell prompt, type `yast2 sw_single <Enter>.
4. Change the filter to Selections.
5. If you are uninstalling the test kit from the TestConsole system, click the check box in front of System Certification Software for the Testconsole until a trash can is present.
   For all other Linux systems, click the check box in front of System Certification Software for the SUT/FS4 until a trash can is present.
6. Click Accept in the lower right corner.

You can also uninstall the test kit by typing the following commands at a shell prompt.

1. Type `rpm -e nstools <Enter>.
2. Type `rpm -e tconsole <Enter>.
3. Type `rpm -e tclink <Enter>.

To verify that the kit was uninstalled, type the following commands at a shell prompt:

1. Type `rpm -q nstools <Enter>.
2. Type `rpm -q tconsole <Enter>.
3. Type `rpm -q tclink <Enter>.
Using TestConsole

This section covers the following topics:

• Section B.1, “Introduction,” on page 59
• Section B.2, “Project Contents,” on page 59
• Section B.3, “Run Queue,” on page 60
• Section B.4, “Project Log,” on page 60
• Section B.5, “TestConsole Testing Modes,” on page 60
• Section B.6, “Troubleshooting,” on page 61
• Section B.7, “Importing Product Information from an Existing Project,” on page 62
• Section B.8, “Submitting Test Results,” on page 62

B.1 Introduction

The TestConsole main window displays three distinct panes: Project Contents, Run Queue, and Project Log. You may display these panes in tiled or tabbed formats. You can change the display in the View menu. We recommend the tabbed view if your monitor has a lower than 1024x768 resolution. Each open test project is displayed on its own tab and can be quickly accessed by clicking on the tab with the test project name.

B.2 Project Contents

The Project Contents pane uses an expanding tree format to display the tests associated with the project you have chosen. For example, to expand or collapse a group of tests, click the plus or minus icons next to the test. There are three columns in the Project Contents pane. The first column displays the title of the test. The second column indicates whether the test is selected to be run with a test group (blank box = unselected, check mark in box = selected). The third column indicates the final test result (untested, pass, fail, etc.). The Project Contents pane may also display a Station Address icon (computer icon) to enable you to select your test station.

B.2.1 Running Tests

1. Double-click any item in the Project Contents pane and the test will start.

2. Right-click any item in the Project Contents pane and choose an item from the popup menu to view its properties.

3. TestConsole saves project files once a test has stopped. This includes product information and test results.

B.2.2 Selecting and De-selecting Tests

To select or de-select a test, click the boxes in the second column. A check mark in the column indicates you have selected the test.
B.3  Run Queue

The Run Queue pane displays the tests that are currently running or queued to run. It displays the test name, the running status and the IP address of the test station.

The Cancel Test button enables you to cancel the highlighted test that is in the Run Queue. The Cancel All button cancels all tests that are queued to run. The Remove Test button allows you to remove a test, even if it is hung.

**NOTE:** When a test is running, the word “running” appears in the status column. If the station under test loses its connection the status column will show two computers disconnected.

B.4  Project Log

The Project Log pane displays a running log of the tests in your test project. It records the time each test started and finished, the result of the test, and other pertinent information.

To display additional information about the test, errors, warnings, and failures in the Project Log pane, run the test in debug mode.

B.5  TestConsole Testing Modes

text goes here

B.5.1  Debug Mode

Debug Mode displays additional information about errors and failures encountered while running the test. This information is displayed in the Event Log pane of the TestConsole window.

Not all test modules support the logging of debug information. To enable debug mode, click the Debug checkbox in the Event Log control bar.

Debug mode runs slower than the normal test mode and can quickly fill up the event log. By default, the log is limited to 10,000 entries. When it exceeds 10,000, the entries at the beginning of the log are lost.

B.5.2  Loop Mode

Loop mode allows you to set up a list of tests or test groups in any order and to run the tests for a multiple number of times in a loop. You can specify loop counts for individual tests as well as groups of tests.

**Editing the Loop Test List**

1. To create or edit the Loop Test List, from the menu bar select *Loop > Edit Loop List*. This will display a dialog box with two panels. The left panel displays the available Project Contents. The right panel displays the Loop Test List.

2. In the Project Contents panel, select the test or group that you want to add to the Loop Test List and click *Add*. The selected items will be added to the loop list. You can continue to add items in any order.
3 To delete a test or group, select the item in the Loop Test List panel and click Remove.

4 To rearrange the order of the tests within a group, right-click the item in the Loop Test List panel and select Move Up or Move Down from the popup menu.

5 To edit the loop count for individual tests or test groups, either double-click the Loop Count column next to the test title or right-click the test title and select Loop Count. This displays a dialog that allows you to edit the loop count properties. The Loop Test List will be saved until the project is closed. You can close the Loop dialog at any time.

Running the Loop Test List

1 If the Loop List dialog window is open, click Run List.

2 If the Loop List dialog window is closed, from the menu bar click Loop> Run Loop List.

NOTE: Currently, loop mode restricts the number of test instances that can be placed on the Run Queue to 100 maximum. For example, if you have 2 tests in a group that run 25 times each with the group itself running 2 times, then you have reached your maximum.

Choose tests to run

1 Choose the test to be enabled

2 Double-click Enable . . . Testing to enable the test.

B.6 Troubleshooting

If “Error attempting to run test” appears on the TestConsole log screen, and the server log or server console reports trouble acquiring a semaphore, then type
SYS:\NovellTestKits\system\NSTOOLS.NCF <Enter> at the server console before running the test again.

It is always best to close TestConsole after each project to make sure that memory is released and data is flushed.

B.6.1 Missing Desktop icon for TestConsole

If you deleted the icon on the desktop for TestConsole, you probably cannot get the icon to reappear on the desktop by reinstalling the kit. The way to get the desktop icon back is to remove the
/root/.skel/tc.icon file, log out and log back into TestConsole.
B.7 Importing Product Information from an Existing Project

You may import product information from an old project into a new project. TestConsole will only import the product information. TestConsole will not import test results. Importing product information will delete all test results of the current project. Import product information before you perform any tests.

1 Start TestConsole.
   1a Bring up the TC workstation.
   1b Double-click the TestConsole icon on the desktop.

2 Open the Project.
   2a Click Project > Open Test Project > New.
   2b Select (Server or Client) - Full or (Server or Client) - Reduced and click Select.
   2c Click Yes at the Warning! window to enter the SUT product information now.

3 Import the project.
   3a Click File > Import Product File.
   3b Click Yes at the Warning! Window.
   3c Browse for the project file to be imported in the /opt/novell/NovellTestKits/System/status directory (e.g., YourFile.TSF).
   3d Click OK in the Product & Report Information window.

4 Save the project.
   4a Click Project > Save Test Project As.
   4b Replace the project name with a unique name (e.g., P2System).
   4c Click Save.

   **NOTE:** TestConsole will import all of the product information into the current project, and it will reset all test results. Remember to change all pertinent information before running any tests.

   4d Make any necessary changes in the product information.
   4e Click OK.

B.8 Submitting Test Results

1 Open the project file.

   **IMPORTANT:** If the project file is already open and you have just completed the tests, save the project before creating the report.

   1a Click the TestConsole icon on the desktop
   1b Click Project > Open Test Project > Existing.
   1c Select the appropriate project.
   1d Click Select to open the project.
2 Create the test report file.
   2a Click Edit Product/Report.
   2b Click Report.

**IMPORTANT:** If the Report Error window appears, continue to step 3. If not, proceed to step 4.

3 Report errors.
   3a Click OK in the Report Error window.
   3b Click Verify.
   3c Click an exception in the scroll window.
   3d Click Edit Explanation.
   3e Enter the explanation.
   3f Click OK in the explain exception window.
   3g Repeat steps c through f until all unresolved exceptions are explained.
   3h Click OK in the Exception Information window.
   3i Click Report.

4 Complete the test results file.
   4a Type the file name of your choice into the File Name field.
   4b Click Save to generate the test results zip file.
   4c Click View Report Summary to view the reported information in a browser.
   4d Close the browser window.
   4e Click OK to exit the Product and Report Information window.

5 Copy the test report ZIP file from the /opt/novell/NovellTestKits/system/results directory to a floppy diskette.
   5a At a prompt, type `cp <result filename> /media/floppy <Enter>`.


**B.8.1 Error Messages**

Error messages will occur for a variety of reasons (e.g., incomplete required information or test results). Error messages indicate problems with required tests or product information. All required tests must be completed or have a valid exception approved by Novell in order to receive a bulletin. TestConsole will produce an error message for each required test that does not pass or have test results. These tests must be completed (or have a valid exception) in order to receive a bulletin.

TestConsole will also generate an error message for each required empty field in the Product and Reporting Information screen forms. Each required field must be completely filled in to receive a bulletin.

**WARNING:** Any changes to fields in the System tab (except the Product Description field) will reset all test results for this product. Contact your assigned Novell engineer if changes must be made to these fields.
B.8.2 Warning Messages

Warning messages also occur for a variety of reasons (e.g., incomplete optional information or test results).

TestConsole will generate a warning message for each optional test that does not have test results. For example, if the Cluster tests are not run, there will be warning messages for each test indicating that they do not have results. In this case, the warning messages may be ignored. TestConsole will also generate a warning message for each optional empty field in the Product and Reporting Information screen forms such as the Company URL.
The following test instruction can be used to install NetWare 6.5 on the SUT if the NetWare 6.5 Installation Test fails.

- TestConsole workstation
- NetWare 6.5

1 Prepare for NetWare 6.5 installation.
   1a Install at least one Novell Developer Services certified LAN adapter for each bus type (minimum two topologies).
   1b Attach a mouse to the SUT.
   1c Attach a storage device to each storage device controller (integrated and stand alone card).
   1d Remove all NetWare and DOS partitions.

2 Boot the SUT from the NetWare 6.5 Operating System CD.
   2a Insert the NetWare 6.5 Operating System CD in the CD-ROM drive. Do not use the Support Pack Overlay CDs, but rather the original release CDs for NetWare 6.5.
   2b Press <I> to install the new server.
   2c Press <A> or <I> or <S> before the timeout expires to boot to an IDE, SCSI or Both CD ROM drive.
   2d Accept the default at the method to restore floppy.
   2e Press <A> at the Install.bat execution screen.

   **NOTE:** If NetWare and DOS partitions exist, the NetWare 6.5 Operating System CD will prompt “Install NetWare, Run NetWare”, and it will time out defaulting to the “Run NetWare” option.

3 Select the English Language install and press <Enter>.

4 Continue the installation process.
   4a Make any needed modifications to the regional settings for the server, then select Continue and press <Enter>.
   4b Press F10 to accept the license agreement.
   4c Press F10 to accept the JReport license agreement.
   4d Press <Enter> to select manual install
   4e Select Continue and press <Enter>.

5 Create a boot partition.
   5a Select Modify and press <Enter>.
   5b Select Free space and press <Enter>.
   5c Press <Enter> to accept the default DOS partition size.
   5d Select Continue and press <Enter>.

6 Select continue and press <Enter> at the Server settings screen. A file copy will start here.
7 Select Continue and press <Enter> for the default Platform Support Module.
8 Modify device types to be installed.
   8a Edit the HotPlug Support Modules list if necessary.
   8b Edit the Storage Adapters list if necessary.
   8c Select Continue and press <Enter>.
9 Modify storage device drivers to be installed.
   9a Edit the Storage devices drivers if necessary.
   9b Select Continue and press <Enter>.
10 Modify device drivers to be installed.
   10a Edit the Network board drivers if necessary.
   10b Edit the NetWare Loadable Modules if necessary.
   10c Select Continue and press <Enter>.
11 Select create and press <Enter> to create volume SYS with the default size.
12 At the Main Menu select Continue Installation and press <Enter>. A file copy starts here.
13 Abort the installation any time after the file copy starts. At this point the SUT has shown that it will successfully boot and transition from real mode drivers to protected mode drivers.
14 Double-click DOS Boot Install Test under the NetWare 6.5 test suite in TestConsole.
   14a If the SUT works properly to this point, click YES to report passing test results.
   14b If the SUT will not install, click No to report failing test results
Identifying Vendor Device IDs

The Linux PCI ID Repository (http://pciids.sourceforge.net/) can help you identify various vendor and device IDs.
## Revision History

<table>
<thead>
<tr>
<th>Date</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>August 11, 2006</td>
<td>Updated Component Check. Minor edits.</td>
</tr>
<tr>
<td>August 9, 2006</td>
<td>Updates to the preface, certification process, policies, and installation instructions.</td>
</tr>
<tr>
<td>October 5, 2005</td>
<td>Updated style and format.</td>
</tr>
<tr>
<td>July 22, 2005</td>
<td>Updated the following tests in the Linux Test Suite: CD-ROM/DVD Test, Serial Port Test troubleshooting, and Hard Disk Test.</td>
</tr>
<tr>
<td></td>
<td>Added OES Bulletins based on NetWare 6.5 SP3 testing-NsPolicy 07082005, Version 1.0 and OES Bulletins based on SLES 9 SP1 testing-NsPolicy 03212005, Version 1.0 to the Policies section.</td>
</tr>
<tr>
<td>June 28, 2005</td>
<td>Updated instruction for entering the product description.</td>
</tr>
<tr>
<td>June 16, 2005</td>
<td>Updated instructions for updating the Products.txt file.</td>
</tr>
<tr>
<td>June 2005</td>
<td>Updated SLES 9 and NLD installation instructions. Updated USB Test information.</td>
</tr>
<tr>
<td>March 16, 2005</td>
<td>Updated Network Client Test Suites.</td>
</tr>
<tr>
<td>March 8, 2005</td>
<td>Added instructions for upgrading TC and FS4 to SP 1. Updated instructions for installing OES.</td>
</tr>
<tr>
<td>February 26, 2005</td>
<td>Updated the Linux USB test and the NLD Client test.</td>
</tr>
<tr>
<td>February 23, 2005</td>
<td>Updated NetWare, Linux, and NLD test suites.</td>
</tr>
<tr>
<td>February 1, 2005</td>
<td>Updated NetWare and Linux test suites.</td>
</tr>
</tbody>
</table>